# Table of Contents

Introduction ......................................................................................................................................................................................... 2
Key Features........................................................................................................................................................................................... 2
What your digital video camcorder includes ............................................................................................................................................... 3
Computer System Requirements for Windows XP ........................................................................................................................................ 4
Computer System Requirement for Windows Vista / Windows 7 ................................................................................................................ 4
Computer System Requirements for Macintosh ....................................................................................................................................... 5
A Quick Look at your Digital Camera .................................................................................................................................................. 6
Inserting Batteries ..................................................................................................................................................................................... 7
Inserting an SD Memory Card ................................................................................................................................................................. 8
Maintenance and Care ............................................................................................................................................................................... 9
Starting Your Camera ............................................................................................................................................................................. 10
Capturing Videos .................................................................................................................................................................................... 12
Video Setting options ............................................................................................................................................................................ 14
Taking Photos ....................................................................................................................................................................................... 18
Photo Capture Settings options ............................................................................................................................................................. 23
Audio Mode .......................................................................................................................................................................................... 30
Playback mode ...................................................................................................................................................................................... 31
Camcorder Setup Mode ..................................................................................................................................................................... 45
Connecting the Camcorder to a TV ....................................................................................................................................................... 51
Install the Vivitar Experience Image Manager Software ................................................................................................................... 52
Connect your camcorder to the computer ........................................................................................................................................... 56
Get photos and videos from your camcorder to your computer ........................................................................................................... 56
Get started! ........................................................................................................................................................................................... 58
Transfer media from my camcorder to my computer manually (Using Windows) ....................................................................................... 59
Introduction

Thank you for purchasing the DVR 508 Digital Video Camcorder. Everything you need to shoot video clips, take quality digital photos and record audio files is included with your device. In addition, an SD compatible memory card of up to 16GB needs to be inserted in order to use the camcorder normally.

Please read this manual carefully FIRST in order to get the most out of your digital video camcorder.

Key Features

- 5 modes – Video, Photo, Audio, Playback and Set Up
- Digital Video resolutions – 1280x720 (HD), 720x480, 640x480 (VGA), 320x240 (QVGA)
- 5 digital camera resolutions - 5M(2592X1944); 3M(2048X1536); 2M(1600X1200); 1M(1280X960); VGA(640X480)
- 1.8” TFT LCD
- 4 X Digital Zoom
- Supports external SD/SDHC memory cards up to 16GB
- Built-in Microphone
- Delete, rotate, protect, crop and print photos directly on and from your camcorder
- Vivitar Experience Image Manager software for uploading and managing photos and videos to or from the most popular photo sharing and social network websites
- Get photos and videos from your camera, manage and organize your images by creating albums, edit images using automatic and manual tools and more...

**What your digital video camcorder includes**

- Digital Video Camcorder
- Vivitar Experience Image Manager software Installation CD
- Quick Start Guide
- USB cable
- TV Out cable
- Pouch
- Strap
Computer System Requirements for Windows XP

To be able to download photos and videos to your PC, you will need the following minimum configuration:

- Pentium 4 processor or above with Windows XP service pack 2
- 512 MB RAM, with 100MB of free disk space
- 1024 x 768 Recommended screen resolution
- 16-bit color or higher display adaptor
- CD-ROM Drive
- QuickTime 6 or higher
- Microsoft Internet Explorer 7 or higher
- Windows Media Player 10 or higher
- Internet connection required

Computer System Requirement for Windows Vista / Windows 7

To be able to download photos and videos to your PC your will need the following minimum configuration:

- Windows Vista / 7
- 800MHz processor and 512 MB of system memory
• 20GB hard drive with at least 15GB of available space
• Support for Super VGA graphics
• Available USB Interface
• CD-ROM drive
• QuickTime 6 or higher
• Microsoft Internet Explorer 7 or higher
• Internet connection required

Computer System Requirements for Macintosh

• Macintosh with Intel processor running Mac OS X v10.5 or later
• 256 MB RAM, 100 MB free disk space
• Display: 1024 x 768 or higher-resolution monitor
• QuickTime 6 or higher
• Internet connection required
A Quick Look at your Digital Camera

1: Lens
2: Microphone
3: Compensating lamp
4: Self-Timer LED
5: Delete
6: Playback
7: Mode
8: TFT LCD Screen
9: Left / Self-Timer
10: Power
11: Down ▼
12: Menu
13: AV Out jack
14: USB jack
15: Right / LED on or off
16: OK
17: Shutter
18: Up ▲ / Display
19: W/Zoom out button
20: T/Zoom in button
21: Speaker
22: Tripod socket
23: Card slot
24: Battery cover
Inserting Batteries

Your camcorder requires three (3) AAA batteries. Insert the batteries into the camcorder:

1. Lift and open the cover of the battery compartment on the side of the camcorder.
2. Insert the batteries according to the polarities (+ and -) indicated on the inside of the battery cover.
3. Replace and close the battery cover.

The battery icon on the bottom left of the LCD will turn red and flash when your batteries are running low, in which case you will need to replace your camera’s batteries. When battery voltage drops to 2.2V, a “Battery Low” message will appear on the LCD and the camera will turn off automatically.

Note: If you do not intend to use your camera for an extended period, remove the batteries to avoid battery leakage and corrosion.
Inserting an SD Memory Card

An SD/SDHC compatible memory card of up to 16GB (not included) needs to be inserted into your DV camcorder in order to save the videos, photos and audio that you capture with your camcorder before transferring them to a computer.

Note: Media sitting on the memory card is not lost when your camcorder’s power runs low or on replacing the batteries.

1. Locate and lift the SD Card cover to reveal the SD card slot on the bottom of the camcorder.
2. Insert an SD memory card correctly in the direction shown.
3. Press the memory card until you hear a “Click” sound. The memory card when properly inserted will sit flush with the camcorder.
Note: After you insert the SD memory card, the SD card icon will appear on the bottom left side of the LCD, indicating that your SD memory card has been installed successfully. The media you capture will now be stored on the card.

- This product supports SD cards of up to 16GB.
- Formatting will delete all data on the SD Memory Card including protected data.
- Do not remove the SD memory Card during formatting as this may damage the card and render it unusable.
- Before using the camcorder, be sure to format the card with the camcorder (see the Setup section further on in the manual for instruction on how to format the card).

**Maintenance and Care**

Before using the video camcorder, please ensure that you read and understand the safety precautions described below:

- Do not try to open the case of the video camcorder or attempt to modify this video camcorder in any way. Maintenance and repairs should be carried out only by authorized service providers.
- Keep the video camcorder away from water and other liquids. Do not use the video camcorder with wet hands. Never use the video camcorder in the rain or snow. Moisture creates the danger of electric shock.
Use only the recommended power accessories. Use of power sources not expressly recommended for this equipment may lead to overheating, distortion of the equipment, fire, electrical shock or other hazards.

Starting Your Camera

Note: To easily download the photos and videos captured with this camera you need to install the Vivitar Experience Image Manager software. See the “Install the Vivitar Experience Image Manager Software” section of this manual to learn how to install the software on your computer.

To power on the camcorder you need to flip open the LCD Screen. The Power button is situated on the inside of the camcorder.

Power on
Press the Power button to turn on your DVR.
The LCD monitor will light up indicating that your DVR is ready for use.

Power off
Press the Power button to turn your DVR camcorder off. The DVR camcorder will switch off.

Auto Power Saving
If the DVR is not in use or in an operation mode for 60 seconds it will switch off automatically.
When there is insufficient battery power, a “Low Battery” message will appear on the LCD screen. The camcorder will automatically power off a few moments later.

Setting the Language
When using the video camcorder for the first time after purchasing it, be sure to choose a language and set the date & time before using the video camcorder.

1. Turn the Power on.
2. Press the MENU button.
3. Press the Right button on the OK dial to open the Setup menu.
4. Press the Up/Down button on the OK dial and select the Language option.
5. Press the Right button to enter the Language submenu.
6. Press the Up/Down button to highlight and select the language you desire.
7. Press the OK button to save your choice and for the language interface of the camcorder to change to the language you selected.
8. Press the MENU button to close the menu and exit the Setup function.

Change the camcorder`s mode
There are four modes in this DVR camcorder.

1. Press the POWER button to turn on the camcorder.
2. The video default capture mode appears on the LCD.
3. Press the **MODE** button on the bottom left of the LCD screen to change the mode.
4. Each time the **MODE** button is pressed the mode icon is changed.

<table>
<thead>
<tr>
<th>Display</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥カメラ</td>
<td>Video mode</td>
<td>For recording movie clips.</td>
</tr>
<tr>
<td>📸カメラ</td>
<td>Capture mode</td>
<td>For taking still photos.</td>
</tr>
<tr>
<td>🎙️マイク</td>
<td>Audio mode</td>
<td>For recording audio files.</td>
</tr>
</tbody>
</table>

## Capturing Videos

In order to capture videos (with audio) using your camcorder you need to select the Video mode. On turning on your camcorder the first mode Video mode appears and is active. To change between the function modes on your DVR, press the **MODE** button on the bottom left of the LCD screen.

A compatible SD card of up to 16GB is needed to capture and save videos.

The video 🎥 icon will now appear on the top left corner of the LCD.
1. The amount of time left at that resolution and memory appears on the top right of the LCD.
2. Aim the camcorder at the subject or object you wish to capture.
3. Press the Shutter button on the top of the camcorder to start shooting.
4. The elapsed time of the video will appear on the top right on the LCD.
5. Press the Up button if you wish to Pause the recording in the middle and again to resume recording.
6. Press the T (Zoom In) or W (Zoom Out) buttons located on the top of the camcorder to digitally zoom into and back out of the object.
7. Press the Shutter button again to stop the recording.
8. The recorded file will be saved in AVI format.

**Note:**
1. You can view the AVI files in playback mode.
2. Once they are downloaded to the PC view them using QuickTime and Windows Media Player.
3. When the memory is full, a “Memory Full” message will flash on the LCD screen when you attempt to shoot further videos.

**LED Lamp**

When light conditions are poor, press the LED / Right button.
Two LED white lamp lights will light up (like a torch) in the front of the camcorder to offer better lighting.
To turn off the LED light, press the LED / Right button again.

**Digital Zoom function**

You can magnify your subject up to 4 times using the digital zoom.
1. Press the **T** button on the top of the camcorder to Zoom In into the object.
2. Press the **W** button to Zoom back out.
3. The digital zoom digit icon appears on the bottom right corner of the LCD screen.

**Video Setting options**

In Video mode there are four video resolutions for you to choose from:
[HD] 1280x720, [D1] 720x480, [VGA] 640x480, [QVGA] 320x240 pixels

The higher the resolution selected the better the quality of the video, however higher quality videos use up more memory. You can also change the Frame Rate, Metering and White Balance.
To enter the Settings options for the Video mode:

1. Press the **MENU** button.
2. Press the **Up/Down** button to select the Setting you wish to change from the menu that appears.
Movie Size

You can select different Video resolutions

1. Press the Up/Down button to select the Movie Size menu.
2. Press the OK button to open the Movie Size submenu.
3. Press the Up/Down button to highlight and select the resolution option:
   
   [HD] 1280x720, [D1] 720x480, [VGA] 640x480, [QVGA] 320x240
   
4. Press the OK button to confirm, save your choice and exit to the Setting menu.
5. Press the MENU button to revert back to the Video capture mode to start capturing videos with
   the new resolution selected.

Note:
After selecting your resolution, the corresponding icon will appear on the top of the LCD.
**Frame Rate**

This setting allows you to control the frame rate for video capture.

1. Press the **Up/Down** button to select the Frame Rate menu.
2. Press the **OK** button to open the Frame Rate submenu.
3. Press the **Up/Down** button to highlight and select the rate option:
   * 30fps High, 15fps Low
4. Press the **OK** button to confirm, save your choice and exit to the Setting menu.
5. Press the **MENU** button to revert back to the Video capture mode to start capturing videos with the new frame rate selected.

**Metering**

This setting allows you to change the brightness of the video.

1. Press the **Up/Down** button to select the Metering menu.
2. Press the **OK** button to open the Metering submenu.
3. Press the **Up/Down** button to highlight and select the metering option:
   - **[Center]**: The exposure will be calculated based on light in the center area and this is suitable for general use.
   - **[Multi]**: The exposure will be calculated based on the average light.
   - **[Spot]**: Only the spot in the center of the LCD screen will be metered for light.
4. Press the **OK** button to confirm, save your choice and exit to the Setting menu.

5. Press the **MENU** button to revert back to the Video capture mode to start capturing videos with the metering selected.

### White Balance

This setting is used to adjust the color balance of your videos as per your light source.

1. Press the **Up/Down** button to select the White Balance menu.
2. Press the **OK** button to open the White Balance submenu.
3. Press the **Up/Down** button to highlight and select the White Balance option:
   - *Auto*, *Daylight*, *Cloudy*, *Fluorescent*, *Bulb*
4. The White Balance choice selected automatically appears on the LCD.
5. Press the **OK** button to confirm, save your choice and exit to the Setting menu.
6. Press the **MENU** button to revert back to the Video capture mode to start capturing videos with the new white balance selected.

### Taking Photos

After you power on your camcorder, press the **MODE** button on the bottom left of the LCD screen.

The camera icon appears in the top left corner of the screen.
Insert a compatible SD memory card of up to 16GB in order to expand capture many more memorable photos.

Use the image that appears in the LCD to compose your shot.

1. Hold the camcorder steady and press the **Shutter** button on the top of the camcorder.

2. Press the **T** (Zoom In) or **W** (Zoom Out) buttons located on the top of the camcorder to digitally zoom into and back out of the object.

3. A capture clicking sound will be heard and the jpeg picture that is taken is saved to the memory card.

4. The number of photos that can be taken for each resolution and per the memory card inserted appears on the top right of the LCD screen.

5. After the shot is taken the number is reduced by one.

6. When the SD memory card is full, “Memory Full” will appear on the LCD screen when you attempt to press the Shutter button to take a photo. Either download the photos to your computer using the Vivitar Experience Image Manager software as described below in the section “Transfer photos and videos to your computer” or insert another SD card to continue taking more photos and videos.

7. The number of photos that can be captured not only depends on the internal memory or the SD card’s capacity but also on the resolution selected. Better quality photos are taken at higher resolutions but these will also take up more memory on the card.
**LED Lamp**

When light conditions are poor, press the **LED / Right** button. Two LED white lamp lights will light up (like a torch) on the front of the camcorder to offer better lighting.

To turn off the LED light, press the LED / Right button again.

**Digital Zoom function**

You can magnify your subject up to 4 times using the digital zoom.

1. Press the **T** button on the top of the camcorder to Zoom In into the object.
2. Press the **W** button to Zoom back out.
3. The digital zoom digit icon appears on the bottom right corner of the LCD screen.

**Self-Timer**

You can include yourself in a photo by using this feature to delay the time between your pressing of the shutter button and when the photo is actually taken. Place the camcorder on a tripod or on a flat and sturdy surface before pressing the Shutter button.

There are 2 methods to activate the Self-Timer.
Method 1:

1. In the camera mode, press the **Left** button.
2. The Self-Timer icon on the top of the LCD will appear.
3. Press the **Left** button until you see the Self-Timer option you wish to use appear:
   - 2 Seconds,
   - 10 Seconds
   - Continue (3 continuous snapshots)
4. Press the **Shutter** button.
5. The digit time countdown appears on the LCD and the red LED on the front of the camcorder next to the lens flashes for every second of the countdown.
6. After the selected time delay the photo will be taken.

Method 2:

1. In the camera mode, press the **MENU** button.
2. Press the **Up/Down** button to select the **Capture Mode** menu option.
3. Press the **OK** button to enter the Capture Mode submenu.
4. Press the **Up/Down** button to highlight and select the Capture Mode option:
   - Self-timer 2S,
   - Self-timer 10S,
Continue (3 continuous snapshots)

5. Press the **OK** button to save your choice.
6. Press the **MENU** button to exit the Setting menu and revert to the Camera mode.
7. The Self-Timer icon appears on the top of the LCD screen.
8. Press the **Shutter** button.
9. The digit time countdown appears on the LCD and the red LED next to the lens flashes for every second of the countdown.
10. After the selected time delay the photo will be taken.

**Continue (Burst)**

Take 3 consecutive photos automatically. You will need enough memory in the camcorder to use this option.

The Continue option is found together with the Self-timer options in the **Capture Mode** submenu.

Using methods 1 or 2 as explained above, select the Continue icon.

1. The Continue icon will appear next to the Camera icon on the top left corner of the LCD.
2. Press the **Shutter** button.
3. The camera will now automatically take 3 continuous photos with intervals of 1 seconds.
The camera setting allows you to manage the way you wish to take photos. You can select and change the Resolution pixel size, Quality, Metering, White Balance, Exposure, Capture Mode and Effects.
To enter the Settings options for the Capture mode:

1. Press the MENU button.
2. Press the Up/Down button to select the Setting you wish to change from the menu that appears.

Resolution

The image size and quality settings determine the number of photos that can be saved and the amount of memory required for each photo. The higher the quality of the photo the more memory it will take. The image size and quality will also affect the maximum size you can print your photo effectively.

To set the camera`s resolution:

1. Press the Up/Down button to select the Resolution menu.
2. Press the OK button to open the Resolution submenu.
3. Press the Up/Down button to highlight and select one of the resolution options:
   
   5M(2592X1944), 3M(2048X1536), 2M(1600X1200), 1M(1280x960), VGA(640X480)
4. Press the OK button to confirm, save your choice and exit to the Setting menu.
5. Press the MENU button to revert back to the Camera capture mode to start taking photos with the resolution selected.

Note:
After selecting your resolution, the corresponding icon will appear on the top of the LCD.

Quality
The quality of your photos also affects the number of shots you can take. The Super setting means you can take fewer photos, but they will be better quality.

1. Press the Up/Down button to select the Quality menu.
2. Press the OK button to open the Quality submenu.
3. Press the Up/Down button to highlight and select one of the quality options:
   
   ![Super fine](image)
   ![Fine](image)
   ![Normal](image)
4. Press the OK button to confirm, save your choice and exit to the Setting menu.
5. Press the **MENU** button to revert back to the Camera capture mode to start taking photos with the quality selected.

**Metering**

This setting allows you to change the area of light exposure of the photo.

1. Press the **Up/Down** button to select the Metering menu.
2. Press the **OK** button to open the Metering submenu.
3. Press the **Up/Down** button to highlight and select the metering option:

   - **[Center]**: *The exposure will be calculated based on light in the center area and this is suitable for general use.*
   - **[Multi]**: *The exposure will be calculated based on the average light.*
   - **[Spot]**: *Only the spot in the center of the LCD screen will be metered for light.*

4. Press the **OK** button to confirm, save your choice and exit to the Setting menu.
5. Press the **MENU** button to revert back to the Camera capture mode to start taking photos with the metering selected.
White Balance

This setting is used to adjust the color of your photos as per your light source.

1. Press the **Up/Down** button to select the White Balance menu.
2. Press the **OK** button to open the White Balance submenu.
3. Press the **Up/Down** button to highlight and select the White Balance option:
   
   *Auto*, *Daylight*, *Cloudy*, *Fluorescent*, *Bulb*

4. The LCD screen automatically changes according to the White Balance selected.
5. Press the **OK** button to confirm, save your choice and exit to the Setting menu.
6. Press the **MENU** button to revert back to the Camera capture mode to start taking photos with the new white balance selected.

Exposure

This setting allows you to manually compensate for unusual lighting conditions such as indirect indoor lighting, dark backgrounds, and strong backlighting. The exposure value range is –2.0 (Dark) to 2.0 (Bright) in increments of 0.3.

1. Press the **Up/Down** button to select the Exposure menu.
2. Press the **OK** button to open the Exposure submenu.
3. Press the **Left/Right** buttons to select the exposure setting as per the present light condition:
The LCD screen automatically changes according to the Exposure selected.

Press the **OK** button to confirm, save your choice and exit to the Setting menu.

Press the **MENU** button to revert back to the Camera capture mode to start taking photos with the new exposure setting selected.

**Note:**
After selecting your Exposure choice, the corresponding icon will appear on the top of the LCD.

**Capture Mode**
Use this mode to activate the Self-timer or Continue 3 shot function

1. Press the **Up/Down** button to select the **Capture Mode** menu option.
2. Press the **OK** button to enter the Capture Mode submenu.
3. Press the **Up/Down** button to highlight and select the Capture Mode options:
   - Self-timer **2S**, Self-timer **10S**, Continue (3 continuous snapshot)
4. Press the **OK** button to save your choice.
5. Press the **MENU** button to exit the Setting menu and revert to the Camera mode.

6. The Self-Timer or Continue icon appears on the top of the LCD screen.

7. Press the **Shutter** button.

8. If you selected the self-timer, the digit time countdown appears on the LCD and the red LED on the front of the camcorder next to the lens flashes for every second of the countdown before the photo is taken. Continue option, on pressing the Shutter button 3 photos will be taken automatically with 1 second intervals.

**Effect**

This setting is used to change the image’s color tone.

1. Press the **Up/Down** button to select the Effect menu.
2. Press the **OK** button to open the Effect submenu.
3. Press the **Up/Down** button to highlight and select the Effect option:
   
   *Normal, B&W, Sepia, Negative, Red, Green, Blue*

4. The LCD screen automatically changes according to the Effect selected.
5. Press the **OK** button to confirm, save your choice and exit to the Setting menu.
6. Press the **MENU** button to revert back to the Camera capture mode to start taking photos with the new effect selected.
Audio Mode

You can record audio clips with your camcorder. The amount of time to record your audio clips depends on how much memory is left after capturing videos and taking photos. Insert an SD card to expand the memory capacity of the camcorder to enjoy many more hours of recording.

After you power on your camcorder, press the MODE button on the bottom left of the LCD screen until the Audio screen appears.

The Audio screen will appear with the audio icon appearing on the top left corner of the screen.
The amount of time that you have to record audio files appears on the top right corner of the LCD.

1. Press the **Shutter** button to being recording.
2. The time left for recording the audio clip appears in the top right of the LCD and counts down as the clip is recording.
3. The lapsed time for the audio clip appears in the center of the LCD.
4. Press the **Up** button to pause the recording.
5. Press the **Up** button again to resume recording.
6. Press the **Shutter** button to stop and save the recorded audio file to memory in WAV format.

**Playback mode**

You can playback the videos, photos and audio files in your camcorder or attach the TV-out cable to watch them on your TV screen.

After you power on your camcorder, press the playback 🎥 mode button on the center left of the LCD panel.

The Playback screen will appear with the Playback 🎥 icon appearing on the top left corner of the screen.

1. Press the **Left/Right** buttons to select the image you wish to view.
2. A **Photo** file appears with the Jpeg 📸 icon appearing in the bottom left corner of the LCD.
3. **A Video** file appears with a Video icon on the bottom left corner of the LCD.

4. **An Audio** file appears with an Audio icon on the bottom left corner of the LCD.

- Photos - In Playback mode you can Lock, Delete, View as Slideshows, change the Effect, Rotate, Resize, add a Voice Memo or Print the photo directly by connecting the camcorder via the USB cable to a Pictbridge compatible printer.
- Videos - You can Lock or Delete the video clips recorded.
- Audio - You can Lock or Delete the audio files recorded.

**Note:**
If there are no images in your memory a “No File” message will appear on the LCD screen.
Thumbnail display

When the camcorder is in the Playback Mode
1. Press the **W** button for all the images to appear as thumbnails.
2. Press the **OK** button for the image to appear in full screen.
3. If you selected a **JPG** file then once in full screen display mode, you can press the **T or W** buttons to Zoom in and out of the photo.
4. Press the **Up/Down/Left/Right** buttons to scroll around the enlarged photo.

**Note:** You can know from the thumbnail what the image is - JPEG files do not have any icons on the thumbnail screen. AVI`s will have a **V** appear on the thumbnail and audio files will have the audio icon.

Operation for still photos

Select a still photo (an icon ![JPG](image.png) will appear on the bottom left corner of the LCD).

1. Press the **T** and **W** buttons to Zoom in or Out of the photo.
2. Press the **Left/Right/Up/Down** buttons to navigate around your photo.
3. Press the **OK** button to exit the Zoom mode and revert back to the original photo.
You now have the option to edit these photos - Lock, Delete, View as Slideshows, change the Effect, Rotate, Resize, add a Voice Memo or Print the photo directly by connecting the camcorder via the USB cable to a Pictbridge compatible printer.

**Lock**
You can lock and protect your photos, videos or audio files from accidental deletion.

1. Press the **MENU** button.
2. Press the **Up/Down** button to select the **Lock** menu.
3. Press the **OK** button to open the Lock submenu.
4. Press the **Up/Down** button to highlight and select one of the lock options:
   
   *Lock/Unlock One; Lock All; Unlock All*

5. If you selected **Lock/Unlock One** and press the **OK** button a “Protect File?” or “Unprotect File?” confirmation message will appear with “Yes” and “No” options.
6. Press the **Up/Down** button to select ‘Yes’ to lock/unlock or ‘No’ to exit.
7. Press the **OK** button to confirm, save and protect/unprotect the selected image.

8. If you selected **Lock All** and press the **OK** button a “Protect All?” confirmation message will appear with “Yes” and “No” options.
9. Press the **Up/Down** button to select ‘Yes’ to lock or ‘No’ to exit.

10. Press the **OK** button to confirm, save and protect all the images.

11. If you selected **Unlock All** and press the **OK** button an “Unprotect All?” confirmation message will appear with “Yes” and “No” options.

12. Press the **Up/Down** button to select ‘Yes’ to unlock or ‘No’ to exit.

13. Press the **OK** button to confirm, save and unprotect all the previously protected images.

**Note:**

After selecting your lock preference, the corresponding lock icon will appear on the left hand side of the LCD for the file(s) selected.

**Delete**

You can delete unwanted photos, videos and audio files at any time to free up memory. You can delete one at a time or delete all the unprotected files that are currently saved on the memory card.

1. Press the **MENU** button.

2. Press the **Up/Down** button to select the **Delete** menu.

3. Press the **OK** button to open the Delete submenu.
4. Press the **Up/Down** button to highlight and select one of the delete options:
   
   *One; All*

5. If you selected **One** and press the **OK** button a “Delete Current?” confirmation message will appear with “Yes” and “No” options.

6. Press the **Up/Down** button to select ‘Yes’ to delete or ‘No’ to exit.

7. If ‘Yes’, press the **OK** button to confirm, save and delete the selected file.

8. If the selected file is locked a “File Locked!” message will appear. To unlock the file follow Steps 1 to 6 in the Lock section above.

9. If you selected **All** and press the **OK** button a “Delete All?” confirmation message will appear with “Yes” and “No” options.

   **Note:** The Delete ‘All’ option will delete all the files saved on the SD card not only the photo files. Please use this feature with caution.

10. Press the **Up/Down** button to select ‘Yes’ to delete or ‘No’ to exit.

11. If ‘Yes’, press the **OK** button to confirm, save and delete all the unprotected images.
Slide Show
You can have all the photos appear one after the other as a Slide Show.

1. Press the **MENU** button.
2. Press the **Up/Down** button to select the **Slide Show** menu.
3. Press the **OK** button to open the Slide Show submenu.
4. Press the **Up/Down** button to highlight and select one of the Slide Show options:
   - *Start; Interval; Repeat*

5. If you select **Start** the Slide Show will begin to play.
6. Press the **Up** button to pause or again to continue.
7. Press the **OK** button to exit the Slide Show

8. If you select **Interval**, press the **Left/Right** button to increase or decrease the interval between images when playing the Slide Show by 1 to 10 seconds.
9. Press the **OK** button to save the time interval and exit.

10. Press the **Down** button to select to the **Repeat** option.
11. Press the **Left/Right** button to toggle between the ‘Yes’ and ‘No’ options if you wish the Slide Show to automatically repeat itself or not.
12. Press the **OK** button to save your choice and exit the Slide Show submenu.

**Note:** On selecting the *Start* option again in the Slide Show submenu the Slide Show will now play according to the new settings selected.

**Effect**
This setting is used to change the image’s color tone.

1. Press the **Up/Down** button to select the Effect menu.
2. Press the **OK** button to open the Effect submenu.
3. Press the **Up/Down** button to highlight and select the Effect option you wish to use:
   
   *Normal*, *B&W*, *Sepia*, *Negative*, *Red*, *Green*, *Blue*

4. Press the **OK** button.
5. A “Waiting…” message appears while the new Effect is saved.
6. The new Effect now appears on the selected image in the Playback mode

**Rotate**
You can rotate photos on the SD card inserted in the camcorder.

1. Press the **Up/Down** button to select the **Rotate** menu.
2. Press the **OK** button to open the Rotate submenu.
3. Press the **Up/Down** button to highlight and select the Rotate options:
   
   *Rotate, Save, Back*

4. To rotate the selected image, select the **Rotate** option.
5. Press the **OK** button to begin rotating the image each time 90 degrees to the right (clockwise).
6. Press the **Up/Down** button to select the **Back** option to undo the last rotate before it is saved.
7. Once you have rotated the image to your liking, press the **Up/Down** button to select the **Save** option.
8. A “Waiting…” message appears while the rotated image is saved.

**Resize**
You can resize a photo on the camcorder

1. Press the **Up/Down** button to select the **Resize** menu.
2. Press the **OK** button to open the Resize submenu.
3. Press the **Up/Down** button to highlight and select the Resize options:
   
   *2048x1536; 1024x768, 640x480*

4. You will only be able to resize down the resolution of the original photo.
**Note:** If the original photo was captured in 5M then it can be resized to any of the options. A 3M photo can be resized to the last 3 options and a 1M photo to the last option. Photos captured in VGA cannot be resized.

5. Press the **OK** button.
6. A “Waiting…” message appears while the image is saved and resized to the resolution you selected.

**Voice Memo**
You can add a voice memo message to a photo on the camcorder

1. Press the **Up/Down** button to select the **Voice Memo** menu.
2. Press the **OK** button to open the Voice Memo submenu.
3. Press the **Up/Down** button to highlight and select the Voice Memo options:

   *Add, Delete*

4. If you wish to add a voice memo select the **Add** option and press the **OK** button.
5. The elapsed time for the voice memo appears in the center of the LCD.
6. Press the **Shutter** button to stop and save the Voice Memo to the photo.

7. The photo with voice memo will now have a white audio icon on the middle left side of the LCD.
8. To play the voice memo in a photo press the **Shutter** button. The voice memo will begin to play.
9. Use the **MENU** button to Stop the voice memo; The **Left** button to Rewind; The **Up** button to pause the voice memo; and the **Right** button to Fast Forward.

10. If you wish to delete a voice memo from a photo, select the **Delete** option.
11. Press the **OK** button. The voice memo and corresponding icon is removed from the selected photo.

### Print
You can print individual photos directly from your camcorder to a Pictbridge compatible printer.

1. In Playback mode select the photo you wish to print.
2. Press the **Menu** button.
3. Press the **Up/Down** button to select the **Print** option.
4. Connect your camcorder to the Pictbridge port of the printer via the USB cable.
5. Press the **OK** button to begin the printing.
6. Press the **Menu** button if you wish to cancel the printing.
7. After the photo is printed you can select another photo to print by pressing the **Left/Right** buttons. Press the **OK** button to print the selected photo.

---

**Operation for AVI video files**

You can playback AVI files (with audio) recorded on your camcorder or view them on your TV when the camcorder is connect to the TV with the TV-out cable provided.

1. Use the **Left/Right** button to select an AVI file you wish to play.
2. A red video icon will appear on the bottom left corner of the LCD to indicate that the image you selected in a video.
3. Press the **Shutter** button to start playing the video.
4. Press the **Up** button to Pause the video and again to continue playing.
5. Press the **MENU** button to stop the playback.
6. Press the **Left** button to Fast Rewind and the **Up** button to pause and play.
7. Press the **Right** button to Fast Forward and the **Up** button to pause and play.

There are 2 setting for the Video playback mode - *Lock and Delete*
Lock

You can lock and protect your video files from accidental deletion.

1. Press the **MENU** button.
2. Press the **Up/Down** button to select the **Lock** menu.
3. Press the **OK** button to open the Lock submenu.
4. Press the **Up/Down** button to highlight and select one of the lock options:
   
   *Lock/Unlock One; Lock All; Unlock All*

5. If you selected **Lock/Unlock One** and press the **OK** button a “Protect File?” or “Unprotect File” confirmation message will appear with “Yes” and “No” options.
6. Press the **Up/Down** button to select ‘Yes’ to lock/unlock or ‘No’ to exit.
7. Press the **OK** button to confirm, save and protect/unprotect the selected file.

8. If you selected **Lock All** and press the **OK** button a “Protect All?” confirmation message will appear with “Yes” and “No” options.
9. Press the **Up/Down** button to select ‘Yes’ to lock or ‘No’ to exit.
10. Press the **OK** button to confirm, save and protect all the files.
11. If you selected *Unlock All* and press the **OK** button an “Unprotect All?” confirmation message will appear with “Yes” and “No” options.

12. Press the **Up/Down** button to select ‘Yes’ to unlock or ‘No’ to exit.

13. Press the **OK** button to confirm, save and unprotect all the previously protected files.

**Note:**

After selecting your lock preference, the corresponding lock icon will appear on the left hand side of the LCD for the image(s) selected.

**Delete**

You can delete unwanted video files at any time to free up memory. You can delete one at a time or delete all the unprotected files that are currently recorded on the memory card at once.

1. Press the **MENU** button.

2. Press the **Up/Down** button to select the **Delete** menu.

3. Press the **OK** button to open the Delete submenu.

4. Press the **Up/Down** button to highlight and select one of the delete options:
   - **One**; **All**

5. If you selected **One** and press the **OK** button a “Delete Current?” confirmation message will appear with “Yes” and “No” options.
6. Press the **Up/Down** button to select ‘Yes’ to delete or ‘No’ to exit.

7. If Yes, press the **OK** button to confirm, save and delete the selected file.

8. If the selected file is locked a “File Locked!” message will appear. To unlock the file follow Steps 1 to 6 in the Lock section above.

9. If you selected *All* and press the **OK** button a “Delete All?” confirmation message will appear with “Yes” and “No” options.

   **Note**: The Delete ‘All’ option will delete all the files saved on the SD card not only the video files. Please use this feature with caution.

10. Press the **Up/Down** button to select Yes to delete or No to exit.

11. If Yes, press the **OK** button to confirm, save and delete all the unprotected images.

---

**Camcorder Setup Mode**

The Setup mode can be accessed from the Video, Camera Capture and Playback modes.

In Setup mode you can set - Sounds, Power Frequency, Power Save, Language, TV Out, USB, Format and Reset All.
1. Press the **MENU** button.

2. Press the **Right** button to select the icon to open the Setup menu.

![Setup menu]

**Sounds**

In this Setup mode you can adjust the sounds the camcorder emits

1. Press the **Up/Down** button to select the Sounds menu.
2. Press the **OK** button to open the Sounds submenu.
3. Press the **Up/Down** button to highlight and select the Sounds options:
   
   *Shutter, Start-up, Beep, Volume*
4. To turn on or off the sound the **Shutter** makes when pressed, use the **Right/Left** button to select ‘On’ or ‘Off’.

5. Press the **OK** button to save your choice.

6. The **Start-up** sound, press the **Left/Right** button to select ‘On’ or ‘Off’

7. Press the **OK** button to save your choice.

8. To turn on or off the **Beep** sound the camcorder makes when pressing a button, use the **Right/Left** button to select ‘On’ or ‘Off’.

9. Press the **OK** button to save your choice.

10. To adjust the sound **Volume** for buttons that emit sounds when pressed, use the **Right/Left** button to select 0, 1, 2 or 3.

11. Press the **OK** button to save your choice.

12. Press the **MENU** button to close the menu and exit the Setup function.

**Power Frequency**

In this Setup mode you can adjust the light frequency depending on the region you are located.

Generally, 60HZ is for the U.S. and Canada, 50HZ for Europe and Japan.
1. Press the **Up/Down** button to select the **Power Frequency** menu.

2. Press the **OK** button to open the Power Frequency submenu.

3. Press the **Up/Down** button to highlight and select the Power Frequency options:
   
   50Hz; 60Hz

4. Press the **OK** button to save the Power Frequency option that you selected.

5. Press the **MENU** button to close the menu and exit the Setup function.

---

**Power Save**

In this Setup mode you can save battery power by selecting the time before the camcorder will automatically power off if the camcorder is left on and not in use.

1. Press the **Up/Down** button to select the **Power Save** menu.

2. Press the **OK** button to open the Power Save submenu.

3. Press the **Up/Down** button to highlight and select the Power Save options:
   
   1 min, 3 min, 5 min

4. Press the **OK** button to save the Power Save option that you selected.

5. Press the **MENU** button to close the menu and exit the Setup function.
Language
When using the video camcorder for the first time after purchasing it, be sure to choose a language before using the video camcorder.

1. Press the Up/Down button and select the Language option.
2. Press the Right button to enter the Language submenu.
3. Press the Up/Down button to highlight and select the language you desire.
   English; French; German; Italian; Spanish; Portuguese, Dutch, Turkey or Russian
4. Press the OK button to save your choice and for the language interface of the camcorder to change to the language you selected.
5. Press the MENU button to close the menu and exit the Setup function.

TV Out
The image of the picture you wish to capture on the LCD can also be displayed on your TV screen instead when using the TV cable provided.
Before using this feature you need to know what the TV setting is for viewing in your region. The incorrect setting will cause images to not appear correctly.

1. Press the Up/Down button and select the TV vOut option from the menu.
2. Press the Right button to enter the TV Out submenu.
3. Press the **Up/Down** button to highlight and select the TV Out option you desire:

   *NTSC, PAL*

4. Press the **OK** button to save your choice.

5. Press the **MENU** button to close the menu and exit the Setup function.

### USB

Your camcorder can be used as a MSDC (Mass Storage device) and is in USB mode by default.

### Format

Using this function will delete all the files (including protected ones) on the inserted SD memory card. **Caution**: Please make sure to download the images first before using this feature as all the files and images sitting on the card will be erased. This process is irreversible.

1. Press the **Up/Down** button and select the **Format** option from the menu.
2. Press the **OK** button to enter the Format confirmation screen.
3. Press the **Up/Down** button to highlight and select the Format option you desire.

   *Yes, No*

4. If you wish to format the memory select ‘Yes’ or ‘No’ to cancel the format.
5. Press the **OK** button to begin the Format.
6. A “Waiting…” message appears on the LCD as the camcorder is formatted.
**Reset All**

Using this function will reset the camcorder to the original factory settings.

1. Press the **Up/Down** button and select the **Reset All** option from the menu.
2. Press the **OK** button to enter the Reset All confirmation screen.
3. Press the **Up/Down** button to highlight and select the Reset All option you desire.
   
   *Yes, No*

4. If you wish to reset the camcorder select ‘Yes’ or ‘No’ to cancel the reset.
5. Press the **OK** button.
6. Press the **MENU** button to close the menu and exit the Setup function.

---

**Connecting the Camcorder to a TV**

Connect the video camcorder to the TV via the supplied cable. Power on the TV and the video camcorder. Make sure that the camcorder TV Out option is the same as that of the TV set (NTSC or PAL). The video camcorder’s LCD screen turns blank, and the image that previously appeared on the camcorder’s LCD screen will now appear on the TV screen.

1. Connect the video camcorder to a TV via the TV-out cable (supplied). The TV slot is situated next to the USB slot at the back of the camcorder. Lift up the cover and insert the cable.
2. Turn on the TV and the video camcorder, and then set the TV to “AV” mode.

3. When the video camcorder is set to record, capture or playback mode, you can preview the images you want to record on the TV screen.

4. When the video camcorder is set to Playback mode, you can review all the pictures, videos and audio clips stored in the video camcorder on the TV.

Install the Vivitar Experience Image Manager Software

Warning: Do not plug your camcorder into the computer until the software installation is complete

You must be connected to the internet to install and run the Vivitar Experience Image Manager software.

1. Insert the installation CD into your CD-ROM drive. The installation screen should automatically open.
2. On PC: The Vivitar Experience Image Manager Installer window appears. If the window does not appear, open the application’s CD/DVD drive and click on “Setup.exe” to launch the installer.

3. On Macintosh: Click the icon to install the Vivitar Experience Image Manager.

4. If you do not have internet access at the time of inserting the CD-ROM, connect to the internet and then click the “Install Vivitar Experience Image Manager” button to begin the installation.
Note: If you do not have internet access, you can still download media from the camcorder. Click the “How to transfer photos and videos from my camcorder to my computer” button for instructions.

5. If you have internet access, the “Choose your language” window opens, choose your language and click “Next” to open the next window.
6. Select your camcorder model from the list and click “Next” to open the next window.
7. Click “Next” to confirm your camcorder model selection and to install the application.
8. Please wait while the application is being installed on your computer.
9. Please review the license terms.
   On PC and Macintosh: Click the “I accept the terms of this license agreement” and then click “Next” to continue.

10. On PC only: Let the “Vivitar Experience Image Manager” installer create the folder to where the program will be installed, and then click “Install”.

11. Please wait while the application continues the installation process on your computer.

12. On PC: Click the “Close” button when the installation is complete.
    On Macintosh: Click the “Quit” button when the installation is complete.

13. Click the “Launch Vivitar Experience Image Manager” to open the application or close the window and run the Vivitar Experience Image Manager from the desktop icons or from the Programs or Applications menus on your computer.
Connect your camcorder to the computer

1. Use the USB cable that came with your camcorder to connect your camcorder to your computer.
2. Turn the camcorder on by pressing the Power On button.
3. The first time you connect the device to the computer you will have to wait a few seconds until the computer recognizes the device.
4. As your camcorder is a mass storage device “MSDC” will appear on the LCD for a second and then the screen will go blank, indicating that your camcorder is in Mass Storage Mode.

Get photos and videos from your camcorder to your computer

An SD card needs to be inserted. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files on their way to your computer.

1. Select the “Get Images” button from the Main menu.
2. The “Get media from device” window opens.
3. You can select to download photos, videos or both.
4. Select your camcorder (removable disk) from the device window. If your camcorder is the only USB device connected then it will be selected automatically.
5. Select a location on the computer where to place the new photo and video files.
6. Add the new photo and video files to albums if desired.
7. Select to remove the media files from the selected device (removable disk) after the import.
8. Click the “Get media” button to transfer the photos and videos from your camcorder to your computer.
9. A media download progress bar appears on the bottom left showing the number of media files downloading to your computer. A message appears when the download is complete.
10. The photo and video files are now downloaded to your computer to the selected folder and albums ready for your use.

Get started!
Using the Vivitar Experience Image Manager, you can:

• Upload and manage photos and videos to and from the most popular photo sharing and social networking sites - Facebook, Flickr, MySpace, Picasa, Photobucket and YouTube.
• Seamlessly transfer photos and videos from one social network to another.
• Organize your images by creating offline and online albums.
• Edit images using automatic and manual tools. Use automatic “Geotagging” with built in Google Maps and more...

For more details on how to use the Vivitar Experience Image Manager open the Help file or click the “Take the Tour” button on the application’s Home page.
Transfer media from my camcorder to my computer manually
(Using Windows)

1. Use the USB cable that came with your camcorder to connect your camcorder to your computer.
2. “MSDC” will appear on the LCD, indicating that your camcorder is in Mass Storage Mode.
3. A window appears with a list of options, select Open folder to view files and click OK.
4. Open the DCIM folder and the folder inside to view the media files.
5. Select the media and copy the files from this folder into your computer. Optionally, select the files and choose Copy from the Edit menu. Then select a folder and choose Paste from the Edit menu.
6. We recommend that you copy the photos into the Pictures/My Pictures folder, the videos into the Videos/My Videos folder and the Audio files to an appropriate folder of your choice.
7. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files on their way to your computer.

Transfer media from my camcorder to my computer manually
(Using Macintosh)

1. Use the USB cable that came with your camcorder to connect your camcorder to your computer.
2. “MSDC” will appear on the LCD, indicating that your camcorder is in Mass Storage Mode.
3. The camcorder’s device icon appears on the desktop.
4. Click on the device icon and open the DCIM folder and the folder inside to view the media files.
5. Select the files and drag them into your computer. Optionally, select the files and choose Copy from the Finder’s Edit menu. Then select a folder and choose Paste from the Edit menu.
6. We recommend that you copy the photo images into the Pictures folder and the videos into the Movies folder.
7. Do not disconnect the cable during transfer. Doing so will cancel the transfer of any files on their way to your computer.

**Note:** After you connect your camcorder to your PC, the camcorder will remain on all the while it is plugged into the USB and it won’t be switched off even though the screen appears to be blank. The red LED on the front of the camcorder indicates that it is still on. On disconnecting the USB cable the camcorder will automatically switch off.

---

**Sakar Warranty Card**

This warranty covers for the original consumer purchaser only and is not transferable. Products that fail to function properly UNDER NORMAL USAGE, due to defects in material or workmanship. Your product will be repaired at no charge for parts or labor for a period of one year.

**What Is Not Covered By Warranty:**
Damages or malfunctions not resulting from defects in material or workmanship and damages or malfunctions from other than normal use, including but limited to, repair by unauthorized parties, tampering, modification or accident.

**What To Do When Service Is Required:**
When returning your defective product (postage pre-paid) for service, your package should include:

1. Copy of **original** bill of sale
2. A detailed written description of the problem.
3. Your return address and telephone number (Daytime)

**MAIL TO ADDRESS BELOW:**

| Sakar / Vivitar US
| Sakar International
| Attention: Service Department
| 195 Carter Drive
| Edison, NJ 08817 | Sakar / Vivitar UK
| Sakar International
| 2D, Siskin Parkway East
| 4020 Middlemarch Business Park
| Coventry, CV3 4PE |
Technical Support
For technical support issues please visit our website at www.vivitar.com. You can find manuals, software and FAQ’s at the website. Can’t find what you are looking for? E-mail us at support@vivitar.com and one of our technical support team members will answer your questions. For phone support in the US please call 1-800-592-9541 or in the UK call 0800 917 4831. If you would like to call from anywhere else, please visit www.vivitar.com for your local toll free number.

Technical Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Resolution (JPEG)</td>
<td>5M(2592X1944), 3M(2048X1536), 2M (1600x1200), 1M(1280X960), VGA(640X480)</td>
</tr>
<tr>
<td>Video Resolution (AVI)</td>
<td>HD 1280x720, D1 720x480, VGA 640x480</td>
</tr>
<tr>
<td>QVGA</td>
<td>320x240</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>15, 30fps</td>
</tr>
<tr>
<td>LCD Display</td>
<td>1.8” TFT LCD</td>
</tr>
<tr>
<td>External Memory</td>
<td>SD card up to 16 GB</td>
</tr>
<tr>
<td>Lens</td>
<td>F=3.0 f=6.5</td>
</tr>
<tr>
<td>Shutter speed Range</td>
<td>1/2 ~ 1/2000 sec</td>
</tr>
<tr>
<td>Digital Zoom</td>
<td>4x</td>
</tr>
<tr>
<td>Continuous Shot</td>
<td>Yes</td>
</tr>
<tr>
<td>TV out</td>
<td>NTSC / PAL</td>
</tr>
<tr>
<td>Feature</td>
<td>Specification</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Microphone</td>
<td>YES</td>
</tr>
<tr>
<td>Speaker</td>
<td>YES</td>
</tr>
<tr>
<td>Recorder</td>
<td>YES</td>
</tr>
<tr>
<td>Self-timer</td>
<td>2sec, 10sec</td>
</tr>
<tr>
<td>File Format</td>
<td>JPEG (Still Image) / AVI (Video) / WAV (Audio)</td>
</tr>
<tr>
<td>White balance</td>
<td>Auto / Daylight / Bulb / Fluorescent / Cloudy</td>
</tr>
<tr>
<td>Exposure control</td>
<td>-2.0 EV to +2.0 EV in 0.3 counts</td>
</tr>
<tr>
<td>Photo Effect</td>
<td>Color, Sepia, Monochrome, Red, Green, Blue</td>
</tr>
<tr>
<td>Language</td>
<td>English, French, German, Italian, Spanish, Portuguese, Dutch, Turkish and Russian</td>
</tr>
<tr>
<td>Power source</td>
<td>3 AAA alkaline batteries</td>
</tr>
<tr>
<td>Auto power off</td>
<td>1mins, 3mins, 5mins</td>
</tr>
<tr>
<td>PC interface</td>
<td>USB2.0</td>
</tr>
<tr>
<td>System Requirements</td>
<td>Windows XP SP2, Vista, 7 MAC OS X 10.5 and higher</td>
</tr>
</tbody>
</table>

**Frequently Asked Questions**

Q: I have taken photos and selected the “Get Images” button. I get a message that the images were successfully transferred but the photos do not appear on my computer. What do I do?

First ensure that you have in fact taken photos. Press the Shutter button to take some sample photos and then try downloading them again.
With test photos if the camera powers off before you upload them to the computer the photos are stored in the camera`s memory. These photos should be uploaded and deleted so that you can take more photos. If the photos are saved to the SD memory card then all the photos should appear.

Q: I deleted images using the Vivitar Experience Image Manager. The photo was also deleted from my computer. How do I recover photos that I accidently deleted?

All images deleted using the Vivitar Experience Image Manager are sent to your computer`s Recycle or Trash Bin and can be retrieved from there.

**Trouble Shooting**

**Power does not turn on.**

1. The Battery is inserted in the wrong direction.  ★Reload battery in the correct direction.
2. The Battery has insufficient power to power on.  ★Replace or recharge the battery.

**The camcorder does not take pictures.**

1. The Memory is full.  ★Insert a new memory card.
2. The Memory card is not formatted correctly.  ★Format the memory card again or use a new card.

**Image is blurry or out of focus.**

1. The video camcorder was moving when the image was captured.  ★Hold the video camcorder steady when shooting picture.